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1. Systémové požadavky 

Minimální systémová specifikace Doporučená systémová specifikace 

Windows XP, Vista nebo Windows 7/8/10 

Pentium 3, 500 Mhz 

2GB RAM 

10GB místa na disku 

3D videokarta s 16 MB VRAM 

800x600, “16-bit High Color” obrazovka 

Windows XP, Vista nebo Windows 7/8/10 

Pentium 4 2.4GHz+ nebo AMD 2400xp+ 

4GB RAM 

50GB volného místa na disku 

3D videokarta s 32 MB VRAM nebo více 

1280x1024 “32-bit True Color” obrazovka 

 

 

Při prvním spuštění musí uživatel zadat produktový klíč. Produktový klíč je na obálce 

softwarového CD. 

 
 

 

 

Lze kliknout na tlačítko "Input Product key” ("Zadat Produktový klíč) v záložce [About QRacing] 
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2. Uživatelé 

2.1 Vytvořit nového uživatele 

QRacing je více uživatelský. Uživatelé mohou přidat nového uživatele připojením GPS přístroje k PC. Jestliže 

přístroj nebyl dosud konfigurován, Qracing automaticky otevře dialogové okno, kde lze upravit název přístroje a 

přezdívku uživatele. 

Pozn.: Název přístroje může mít max. 14 znaků, pvoleny jsou jen anglická písmena a číslice. 

 

2.2 Ú prava jmen 

Přidaný uživatel se objeví v levé části okna. Qracing umoňuje uživatelům měnit názvy přístroje a přezdívky. 

Kliknutím na název uživatele v levé části vyvolá zobrazení názvu přístroje a přezdívky v pravé části okna. Pak 

klikněte na "Rename" ("Přejmenovat") tlačítko, což dovolí provedení změn. 

 

 



                                                                                               QRacing™ 
…………………………………………………………………………………………………………………………………………………………………………………………………………………………. 

  6 
 

  

 

3. Stažení dat 

3.1 Pro modely LT-Q6000, LT-6000S 

Přístroj vypněte a připojte k PC. QRacing se zeptá, zda má načíst data záznamu, pokud v přístroji nějaká jsou. 

Kliknutím na "YES" ("Ano")se povolí stahování dat. 

 

 

 

 

 

 

 

 

 

Vyberte typ závodu:  

* Typ "Rally" podporuje pouze model LT-6000S  

 

 

 

Vyberte ze seznamu záznam/y, který se má z přístroje nahrát: 
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QRacing se potá zeptá, zda se mají nahrát i majáčky z přístroje k danému záznamu. Kliknutím na "Yes" ("Ano") se 

stáhne soubor  majáčky, kliknutím na  "No" ("Ne") se majáčky budou muset nastavit v programu QRacing. 

(Pod pojmem "Majáček" se rozumí startovní čára, cílová čára a rozhraní okruhu/etapy, kde je zobrazován 

mezičas.) 

 

 

 

 

 

 

 

 

3.2 Pro model Q1000EX 

Zapněte GPS přístroj a připojte jej k PC. Switch ON the GPS device and connect with PC, QRacing se zeptá, zda 

má načíst data záznamu. Kliktuním na "YES" se zobrazí dialogové okno: 

 

 

 

 

 

 

 

 

Zde zvolte typ závodu, který chcete. 

Jestliže vyberete typ “Drag Racing” ("Sprinty"), musíte zadat vzdálenost pro tento typ závodu a případně vybrat 

typ jednotek vzdálenosti. 
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3.3 Načtení/Smazání/Resetování přístroje 

 

 

Záznam lze načíst kliknutím na název uživatele v levé části okna a pak na tlačítko "Read Log" ("Načíst Záznam") v 

dialogu. Záznam lze také načíst pomocí volby z roletky menu "File" ("Soubor")  "Read Log" ("Načíst Záznam"). 

Podobným způsobem lze záznam v přístroji také vymazat. 

Reset na tovární bastavení se provede kliken na [File]-> [Reset Device] ([Soubor] -> [Reset přístroje]). 

4. Konfigurace zařízení (jen pro model BT-Q1000eX) 

Po připojení Vašeho přístroje k PC můžete váš GPS přístroj nakonfigurovat. Na stránce uživatelských nastavení 

klikněte na "Configure" ("Nastavit"). V dalším okně se poté dá nastavit vibrační senzor, bzučák a chování paměti. 

 

 

 

 

 

 

5. Nahrání AGPS  

AGPS (Almanach GPS) urychluje fixaci polohy a vylepšuje spolehlivost. AGPS můžete nehrát nebo smazat volbou z 

menu [File]  [Download AGPS] ([Soubor]  [Nahrát AGPS]). 
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6. Nástroje možnosti 

V liště nabídek, klikněte na [Tools] --> [Options] ("Nástroje" -> "Možnosti"). Zde můžete konfigurovat Jednotky, 

Koordináty, vybrat Jazyk, Oddělování tras, nastavit prodlevu zobrazení G-hodnot, Povolit/Zakázat automatické 

nahrávání AGPS nebo aktualizovat přístrojový firmware a zvolit si cestu k poracovnímu prostoru QRacing na 

disku. 

 

 

7. Seznam záznamů 

Dvojitým kliknutím na vybranou trasu přejde QRacing na stránku Analýz. 

Pokud typ závodu neodpovídá, lze jej opravit vybráním správného typu ze seznamu typů závodu. 

Chcete-li, je možné trasu vymazat klikem na tlačítko "Remove Track" ("Odstranit trasu"). 

 



                                                                                               QRacing™ 
…………………………………………………………………………………………………………………………………………………………………………………………………………………………. 

  10 
 

  

7.1 Práce se závodními tratěmi 

QRacing podporuje práci se závodními tratěmi. Pokud se v databázi QRacing(u), software se zeptá, zda chcete 

nastavit název tratě. Pak je možné filtrovat záznamy z tratí podle názvu tratě. 

 

 

Název tratě lze upravovat proklikáním na [Beacon] --> [Edit Field] ([Majáček] -> [Ú prava pole]): 

 

 

 

 

 

 

 

 

 

 

 

 

Upravit název lze také dvojklikem na název trati a také je možné trať vymazat kliknutím na tlačítko "Delete" 

("Smazat") 

 

8 Databáze map tratí 

Qracing má vestavenou databázi map tratí a také automatické nalezení a zobrazení Mapy závodní tratě. 
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Při zaškrtnuté volbě "Adjust Map" (Úprava mapy") lze přetáhnout zaznamenané trasy do správné polohy vůči 

mapě. 

 

 

 

 

 

 

 

atabázi map nebo její aktualizaci si můžete stáhnout kliknutím v menu [Help] -> [Update Track Map] ([Pomoc] -> 

[Aktualizovat Mapy Tratí]). 
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8.1 Nastavení závodní tratě 

 

Pokud databáze traťových map v QRacing neobsahuje Vaši trať, můžete si vytvořit vlastní mapu. 

 Jízdou po trati zaznamenejte jedno kolo projeté při vnitřním okraji dráhy a jedno kolo při vnějším okraji dráhy. 

Stáhněte tato data do QRacing softwaru a klikněte na tlačítko “Set Racing Track” ("Nastavení závodní tratě"), pak 

yberte tato tvě projetá kola k vyznačení hranic Vaší nové závodní dráhy. 

 

 

8.2 Poznámka k trati 

Po načtení záznamu jízdy ze zařízení můžete k trati přidat poznámku. Nejprve označte zvolenou trať a pak její 

záznam upravte v poli níže. 
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8.3 Majáček 
Pokud jste ještě neupravili majáčky k této trati, požádá QRacing o jejich úpravu. 

To umožní softwaru QRacing analyzovat Vaše data ze závodů. Na stránce Beacon (Majáčky) můžete zvolit mezi 

přednastavenou sadou nebo si vytvořit sadu vlastní. 

K dispozici jsou čtyři typy majáčků, Start/Cíl, Start, Cíl a Mezičas, které můžete použít v závislosti na typu závodu. 

 
 

Pro závod typu Drag Racing (Sprinty) je k dispozici pouze jeden typ majáčku; vše, co je třeba udělat, je použít 

majáček typu “Set Valid lap” ("Nastavit platné kolo") k označení platných kol z vaší trati. QRacing automaticky 
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vypočte a analyzuje uživatelsky definované vzdálenosti nebo rychlosti tohoto typu závodů. 

 

 

 

U závodního záznamu typu Rally můžete k průjezdním bodům přidat další detaily (název a poznámku) a následně 

vytisknout takto vytvořený Roadbook pro chystanou Rally. Klikněte na volbu Export Roadbooks (Exportovat 

Roadbook) a zvolte uložit jako HTML soubor, a ten pak vytiskněte pomocí funkcí Tisk z prohlížeče.* Rally 

podporuje pouze LT-6000S 

 

 

Jestliže znáte souřadnice majáčku, který chcete umístit zadejte je ve volbě: Menu --> [Beacon] --> [Input Reference 

Coordinate] (Menu -> [Majáčky] -> [Vložit Referenční Souřadnice]), kde zadáte souřadnice k označení polohy 

Vašeho majáčku. 
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8.3.1 Vymazání majáčku 

Vymazání majáčku provedete najetím nad daný majáček myší, klikem na pravé tlačítko myši a potvrzením 

vymazání. Talčítkem “Delete All Beacon” ("Vymazat všechny majáčky") lze vymazat celou sadu majáčků dané trati 

najednou. 
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8.3.2 Úpravy sad majáčků 

QRacing V3.3 podporuje více sad majáčků pro jednu traťovou mapu a tak analyzovat závod podle různých sad 

majáčků.  

Klikněte na Click Menu --> [Beacon] --> [Beacon Set..] (Menu -> [Majáčky] -> [Majáčková Sada ..] k ovládání a 

úpravám vlastních majáčků. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.3.3  Export/Import Majáčků  

Můžete také sady majáčků exportovat a sdílet informace k závodní trati s přáteli. Stačí k tomu klik na “Beacon 

Export” ("Export majáčků") a “Beacon Import” ("Import majáčků"). 
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8.3.4 Export QRacing souboru majáčků do přístroje (pro LT-Q6000, LT-6000S) 

V software QRacing si můžete vytvořit linie: Start/Cíl čáry, Mezičasů, a pak vše exportovat do zařízení k 

zobrazování mezičasů při závodu.  

V záložce “Beacon” ("Majáčky")klikněte na tlačítko “Beacon Export” ("Export majáčků") >> “Export Beacon to 

device” ("Exportovat majáčky do zařízení"). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.4 Analýzy 

Po nastavení majáčků přejděte na záložku Analýz, kde budou vidět analyzovaná data ze závodu. 

QRacing automaticky použije kolo s nejlepším časem jako referenční kolo ke srovnávání. Klikem na "Reference 

Lap Setting" ("Volba referenčního kola")se otevře dialog, kde lze vybrat kterékoliv jiné z kol jako referenční. 

Setting: 
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K dispozici jsou čtyři různé tabulky analýz, Průměrná/Max/Min Rychlost, Sektory (od začátku sektoru ke konci 

sektoru), Mezičasy (od Startu-k-Mezičasu) a Přehled aktuálních rychlostí v průjezdních bodech. Zvýrazněny 

budou rekordní hodnoty v každé tabulce analýzy a nejrychlejší čas kola. 

Pro váš přehled o výsledcích spočítá QRacing rovněž "Best Theoretical Time" (tj. Nejlepší Teoretický čas Start-Cíl 

z nejlepších časů v sektorech okruhu) a dále "Best Rolling Time" (Nejlepší čas souvislého průjezdu celou délkou 

okuhu složený z nejlepších na sebe navazujících sektorů). 

 

Prohlédněte si výše uvedené vzorové tabulky: nejlepší teoretický čas je prostý součet nejlepších časů 

jednotlivých sektorů ze všech kol – zvýrazněny modře.  

Nejlepší čas souvislého průjezdu je součet nejlepších navazujících sektorových časů, v příkladu je to sekvence 

od Kolo4 (sektor 3-F) do Kolo5 (sektor 2-3). 4asy jsou zvýrazněny podtržením. 

Porovnávání lze provést i se záznamy z jiných jízd. Klikněte na “Comparison” ("Porovnání")a vyberte si záznam, 

se kterým se bude porovnávat. Tabulky analýz se pro Vás automaticky zaktualizují. Viz. též oddíl 7.5. 

 

Comparison (Porovnání) 
Pokud potřebujete axportovat analýzu, můžete kliknout na “Export Lap Info…” ("Export Informací o Kole ..") a 

QRacing připraví výstup ve formátu z těchto možností: 

Excel, CSV nebo HTML. 

U analýzy sprint závodů rozdělí QRacing automaticky rychlost sprintu do několika segmentů a zobrazí čas každého 

segmentu a vzdálenost jak je vidět v příkladu níže: 
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8.4.1 Analýza výkonu (v HP) 

QRacing umí odhanout průměrný a maximální výkon vašeho vozidla (v HP) v nastavení na závod ve sprintu na 

1/4 míle. Musíte zadat jak hmotnost vozidla v okamžiku jízdy tak hmotnost posádky, aby vypočtený odhad výkonu 

byl přesný. 

Pro zadání hmotností klikněte na "Update" ("Aktualizace").* Poznámka: Odhad výkonu vozidal umožňuje jen 

závod Sprint 1/4 

 

 

 

 

 

 

 

 

 Analyzovat lze také diagram závislosti rychlosti versus výkon v HP na záložce "Track" ("Trať"). 

 

 

 

 

 

 

 

 

Note: toto je pouze odhad výkonu vypočtený z GPS dat a jako takový při správném provedení bude 

pravděpodobně přesný na 5% ze skutečné hodnoty. 
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8.5 Trať 

8.5.1 Mapový pohled 

 Na záložce Track (Trať), můžete zobrazitaž tři kola najednou a analyzovat průběh a data. Jednotlivá kola lze také 

porovnávat na spojnicovém grafu podle vzdálenosti nebo času. 

 

 

 

 

 

 

 

 

 

 

 

Pro Sprint závody je možný ještě další typ analýzy. Můžete trať rozdělit na 4 nebo 10 segmentů a následně se 

zobrazí trvání každého segmentu. 

 

 

 

 

 

 

 

 

 

V Mapovém pohledu si můžete na trati, nebo v čarovém diagramu přidat značky ve třech barvách, červené,  

zelené a bílé. Tak si lze označit akcelerační, brzdné nebo jiné body. 
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8.5.2 Nastavení preferencí trati 

 V Menu > Tool > Preference (Menu -> Nástroje -> Preference) nebo klikem na tlačítko Preference lze nastavit 

preference pro přehrávání záznamu průjedu trasy. 

 

 

 

 

 

 

 

 

 

 

 Zobrazit G-hodnoty: Zobrazí se čáry znázorňující hodnoty G při přehrávání průběhu jízdy.  

 
 

 Zobrazit distribuci G-Hodnot: Tato volba zobrazí zónu rozptylu hodnot G vybraných kol jízdy.  
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 Zobrazit brzdnou linii: Zobrazí se čísti trasi, kde docházelo ke zpomalování. Na zobrazení tras lze porovnávat 

průjezdy a získat informace o zrychlování a brždění. (Silnější část grafu průjezdu kola reprezentuje zóny 

brždění, tenká čára je akcelerace.)  

 
 

 

 Natočení trasy: Zobrazení dráhy/trasy lze natáčet v rozsahu 360°. 

    

 

 Zobrazit mapu: zatržením této volby se na stránce Trasa zobrazí mapa okruhu/dráhy. 

  

 

8.5.3 Pohled Přehrávání 

Klikněte na tlačítko Play na stavové liště. To přehrává vybraná 3 kola a zobrazuje informace o průběhu jízdy 

podle času, rychlosti a rozptyl G-hodnot současně. 

Ve spodní části obrazovky se zobrazí zóna rozptylu hodnot G a zároveň se na diagramu trati zobrazuje G-hodnota 

formou čárky pro porovnání. 
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Chcete-li, můžete porovnat váš průjezd s průjezdem jiného jezdce a zjistit, od kterého sektoru jel lépe než vy. 

Můžete zvolit, od kterého mezičasu se má přehrávání začít. 

I 

 

 

 

 

 

 

 

 

 

 

 

 Rychlost přehrávání lze nastavit na 1, 1/2 nebo 1/4 násobek skutečné rychlosti.  
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8.6 Porovnání 

Klikněte na “Comparison” ("Porovnání") a zobrazí se přehled: 

Kliknutím na “Comparison” ("Porovnání"), můžete vybrat trasy ze stejného typu závodů (Okruh, Sprinty,nebo Rally) 

a porovnávat tak s jízdami jiných uživatelů. 

 
 

8.7 Ignorovat 

Můžete označit kola, která se mají ignorovat, klikem na “Ignore” ("Ignorovat"). Poté budou ignorovaná kola 

mítnázev “Lap0”. Ignorování se zde dá také zrušit. 
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9.Export/Import Tratí  

9.1 Export Tratě 

Záznam nejlepších jízd je možné sdílet s přáteli nebo je zálohovat pomocí exportu do souboru s příponou .rcn 

(typ souboru podporovaný softwarem QRacing) nebo souborů jiných typů: (KML, GPX, NMEA, and CSV). 

Klikněte na [File] --> [Export Tracks] ([Soubor] -> [Export Tratě]). Vyberte úplný záznam tratě (*.rcn soubor) nebo 

v jiném formátu a vyberte záznamy, které chcete exportovat. 
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9.2 Import Tratě 

Klikem na [File] --> [Import Track] ([Soubor] -> [Import Tratě]), vyberte import zvolené tratě (jen soubory typu 

*.rcn), a QRacing vyvolá dialog pro volbu typu závodu. 

(Můžete si také zvolit záznam dat jiného jezdce (*.rcn) ze stránek QStarzYou a importovat je to QRacing za 

účelem porovnání a analýzy). 
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10. Video 

QRacing umožňuje synchronizaci videa ze závodu se záznamem tratě. Na liště záložek klikněte na záložku 

"Video" a zahajte nastavení synchronizace.   

 

10.1 Nastavení Videa 

V záložce Video klikněte na tlačítko “Set video for track...” ("Nastavit Video pro trať …") a zobrazí se dialog 

pro nastavení videa. Zde můžete přidat, odstranit nebo upravit videa. (Pozn.: QRacing podporuje až 9 video 

souborů ve formátech avi, mov, wmv, mp4, and mpg. Některá videa však nemusí být možné přehrát v závislosti 

na tom, jaké kodeky byly použity pro kompresi a které máte instalované ve Vašem PC. V závislosti na výkonnosti 

Vašeho počítače zvyšování počtu video souborů může způsobovat prodloužení prodlev videa, zejména s video 

soubory v HD kvalitě.) 
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Pořadí zobrazování videí lze změnit v dialogu "Set videos for track" ("Nastavení videí k trase"), vyberte video a 

klikněte na "up" ("nahoru") nebo “down” ("dolu")podle požadovaného umístění ve frontě. 

 

 

 

 

 

 

 

 

 

 

 

 

10.2 Nastavení momentu začátku videa 

V dialogu nastavení videa vyberte požadoané video a klikněnte na tlačítko úprav. Zobrazí se dialog nastavení 

začátku video sekvence takto, 

 * V nahrávce může být obsah, který se nevztahuje k závodu. Měli byste nastavit začátek závodní videosekvence 

synchronizovaně se záznamem trasy. 

1. Spusťte přehrávku videa dokud nedojdete k místu, které se kryje se startovní pozicí a v tomto okamžiku 

zastavte přehrávku. 

2. Klikněte na “OK”, tím se dokončí editace. 
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11. Záchyt obrazovky 

Software QRacing vám umožňuje zachytit smímek pracovní plochy QRacing podle obrázku níže. 

Soubor se snímkem pracovní plochy se uloží do složky QRacing_Workspace. 

 

 

 

12. Google Earth 

Záznam trasy můžete zobrazit a prohlížet na mapách Google Earth klikem na Tools >> View in Google Earth…  

(Nástroje -> Náhled v Google Earth). 

(Pozn.: Na počítači musíte mít nainstalovaný Google Earth program.) 

 

 

 

 

1 

2 
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13. Kontrola aktualizací softwaru/firmwaru (modely LT-Q6000, LT-6000S) 

Na liště Menu v položce Help -> Check Update (Pomoc -> Zkontrolovat Aktualizace) můžete zjistit dostupné 

aktualizace QRacing a nebo Firmwaru. 

 

 

QRacing zjistí nejnovější aktualizace nebo verze softaru ze serveru Qstarz. Pokud existuje novější verze, 

QRacing požádá o potvrzení zda se má provést stažení aktualizace. Je-li připojené zařízení, zkontroluje 

QRacing také dostupnost aktualizací Firmwaru a automaticky jej nahraje do zařízení. Po dokončení nahrávání 

do přístroje odpojte zařízení. Aktualizace se dokončí současnýcm stisknutím a přidržením tlačítek přístroje 

"Enter" a "Napájení". 

14. Sledovat Qstarz na Facebooku 

Klikem  na toto tlačítko otevře QRacing váš předvolený prohlížeč a přejde na stránky Qstarz Motosport GPS Lap 

Timer skupiny na Facebooku. Do skupiny se můžete přidat klikem tlačítko na “Ask to Join Group” ("Požádejte o 

přidání do skupiny"). 
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15. FAQ (často kladené otázky) 

Existuje QRacing Windows 8 driver? 

Ano, pošlete prosím e-mail s požadavkem na poskytnutí driveru pro Windows 8 na adresu info@qstarz.com. 

 

Moje mapa trati se v QRacing nezobrazuje? 

Prosím zkuste aktualizovat Trackmap databázi, nebo exportujte trať jako .rcn soubor a pošlete jej e-mailem na 

adresu info@qstarz.com My vytvoříme mapu trati a aktualizujeme Tackmap databázi. 

Svou mapu si můžete vytvořit také sami. Popis je v kapitole 8.1. "Nastavení závodní tratě". 

 

 


